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STRUCTURAL EQUATION MODELING WITH LISREL:  

AN INITIAL VISION 
 

 

ABSTRACT  
 

LISREL is considered one of the most robust software packages for Structural Equation Modeling with covariance 

matrices, while it is also considered complex and difficult to use. In this special issue of the Brazilian Journal of 

Marketing, we aim to present the main functions of LISREL, its features and, through a didactic example, reduce the 

perceived difficulty of using it. We also provide helpful guidelines to properly using this technique. 
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MODELAGEM DE EQUAÇÕES ESTRUTURAIS COM LISREL:  

UMA VISÃO INICIAL 
 

 

RESUMO  

 

O LISREL é tido como um dos mais robustos softwares para modelagem de equações estruturais com matrizes de 

covariância, ao mesmo tempo em que é considerado um pacote estatístico complexo de difícil utilização. Neste 

número especial do Brazilian Journal of Marketing, buscamos apresentar as principais características do LISREL, 

suas funcionalidades e, por meio de um exemplo didático, reduzir a dificuldade percebida em seu uso. 

 

Palavras-Chave: LISREL; Matriz de Covariância; Modelagem de Equações Estruturais; Aplicação de LISREL no 

Marketing. 
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1 INTRODUCTION 

 

  Structural equation modeling (SEM) is a 

procedure for estimating a series of dependence 

relationships among a set of concepts or constructs 

represented by multiple measured variables and 

incorporated in to an integrated model.  SEM is 

mainly used as a confirmatory, rather than 

exploratory, technique. 

   It is very important that a SEM model be 

based on a theory because all relationships must be 

specified before the SEM model can be estimated. A 

construct is an unobservable or latent variable that can 

be defined in conceptual terms but cannot be 

measured directly. Rather, a construct is measured 

approximately and indirectly by examining the 

consistency among multiple observed or measured 

variables. It is recommended that each construct be 

measured by using at least three observed variables. 

  The LISREL (Linear Structural 

Relationships) was developed in 1970 by Karl Gustav 

Jöreskog and Dag Sörbom, while they were 

researchers at the Educational Testing Services and 

Princeton University. Since LISREL’s development, it 

has been recognized as one of the best solutions for 

the estimation of structural equation models for 

covariance matrices. 

   The creators of LISREL had the intention of 

developing comprehensive statistical software, which 

ran on a DOS operating system and provided 

independence from other statistical programs, and thus 

it is considered a difficult program to learn and apply. 

Due to this, several friendlier versions have been 

developed using the Windows environment and 

providing more simplified programming languages. 

However, many users, especially begginers, think that 

even the friendlier versions are still complex and 

difficult to use. A basic difficulty is learning the 

conventions adopted for the representation of 

variables and associations, due to the use of matrix 

algebra using Greek letters and symbols. Another 

difficulty is the understanding of the essential 

information that is provided by the outputs. 

   Assuming readers have a basic knowledge of 

SEM (Structural Equation Modeling), the aim of this 

work is summarized in a simple and didactic 

language: to explain the main features of LISREL and, 

at the same time, illustrate the benefits of its use in 

marketing research.  

   The article is structured in four parts, beyond 

this brief introduction. Section 1 presents a brief 

history of the conception of LISREL. In section 2, we 

present the main features of structural equation 

modeling using LISREL. The following section 

describes a practical application of LISREL to use the 

graphical interface of the program - the Path Diagram. 

The fourth section contains the concluding remarks. 

 

   1.1 Brief History of LISREL 

      

  In 1970, the Swiss statistician, Karl Gustav 

Jöreskog, PhD, along with his student Dag Sörbom, 

today also a teacher and PhD in Quantitative Applied 

Economics at Uppsala University, developed an 

algorithm to analyze structural models with latent 

variables. This algorithm, which is the basis of 

LISREL, resulted from background studies in which 

Jöreskog devised a reliable method for calculating 

maximum likelihood estimates for exploratory 

factorial analyzes and, in 1969, an algorithm for 

calculating the confirmatory factor analysis with the 

use of commands in Fortran programming language. 

   The first version of LISREL, still in DOS, 

had no graphical interface to facilitate the 

operationalization of structural equation modeling. 

The construction of computational logic was done 

using commands called LISREL syntax - also 

available in the current version. 

   In the versions after 1993, the user can 

choose the method by which to use the software for 

analysis of the model. Options include LISREL 

syntax, the Simplis syntax and the graphic interface 

Path Diagram.  

Table 1 presents the development of the 

different versions of LISREL. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
Structural Equation Modeling with use of Lisrel: an initial vision 

    _______________________________________________________________________________  

_______________________________________________________________________________ 

 

 

30 

LOPES / VEIGA /  
MALHOTRA 

 

Brazilian Journal of Marketing - BJM 

Revista Brasileira de Marketing – ReMark  
Edição Especial Vol 13, n. 2. Maio/ 2014 

 

 

Table 1 – Versions of LISREL 

 

YEAR DEVELOPMENT OF LISREL 

1970 Release of version I. 

1972 Upgrade to version II, incorporating multi-group analysis. 

1974 
Upgrade to version III. In this year SSI (Scientific Software International) begins commercial distribution 

of LISREL 

1978 Upgrade to version IV. 

1981 Upgrade to version V. 

1984 Upgrade to version VI. 

1988 
Upgrade to version 7, which is the first for Windows environment. Introduction of graphic interface Path 

Diagram. 

1993 Upgrade to version 8 and introduction of SIMPLIS language. 

1998 Upgrade to version 8.2. 

1999 Upgrade to version 8.3. 

2001 Upgrade to version 8.5. 

2004 Upgrade to version 8.7. 

2006 Upgrade to version 8.8. 

2008 Upgrade to version 9. 

2012 Upgrade to version 9.1, which is the latest version available. 

 

 

 

2 USING OF LISREL 

 

LISREL is commonly used for structural 

equation modeling for covariance matrices. It is, 

however, a rich statistical package in which it is 

possible to treat quantitative data using various 

techniques, such as exploratory and confirmatory 

factor analysis, linear regression, probit and logistic 

regressions, handling and processing of data, 

modeling multilevel structural equations, generalized 

linear models, multilevel linear models, multilevel 

generalized linear models, and nonlinear models, 

among others. 

Due to the close relationship made between 

LISREL and structural equation modeling (SEM, from 

this point on), several authors have referred to 

structural models as "LISREL models", regardless of 

whether this software was used or not in the data 

analysis. The use of LISREL as a tool for SEM should 

be grounded on two characteristics of the data analysis 

strategy: 1) the type of matrix associations in data 

entry, and 2) desired parameters of the estimation 

technique. 

For data entry, the researcher must decide 

between a correlation matrix and a covariance matrix. 

The majority of statistical theory that supported the 

development of SEM technique assumes that the 

analysis applies to a covariance matrix, and this is 

therefore the most natural form of data entry. Bentler 

et al. (2001) argue that the use of a correlation matrix 

results, in general, in incorrect estimates of standard 

errors. Moreover, the model covariance structure also 

has standard solutions and therefore also provides 

estimates of the correlations and standard effect at the 

end of the analysis. For the correlation analysis, 

according to Bentler et al. (2001), the performance of 

several consecutive linear regressions would be 

sufficient, but cannot be applied because the analysis 

of covariance, in these cases, would give power to the 

residual error. Even if Chin (1995) recommends the 

use of correlation matrices for analysis of complex 

theoretical models and models of formative 

measurement, Bagozzi and Yi (1988) argue that 

researchers in the psychology of consumption should 

choose the covariance matrices for all analyses. 

Another key decision in choosing the LISREL 

is the choice of the estimation technique. The method 

of maximum likelihood estimation is used in most 

statistical programs and is more widespread in use 

(Anderson and Gerbing, 1988). The estimation 

produced by maximum likelihood is reliable and 

robust with respect to moderate violations of 

normality as long as the sample has at least 100 

observations (Anderson and Gerbing, 1988). Although 

there are methods of estimation in LISREL that are 

not dependent on the assumption of normality of the 

data, such methods are of limited application because 

they require very large samples. For example, the 

weighted least squares method (Weighted Least 

Squares - WLS) requires a sample sized by the 

product of the manifest variables or indicators of the 

same model as this quantity multiplied by another - for 

example, a model of 50 manifest variables would 

require 2,550 respondents (n = 50 x 51 = 2,550). For 



 

 
Structural Equation Modeling with use of Lisrel: an initial vision 

    _______________________________________________________________________________  

_______________________________________________________________________________ 

 

 

31 

LOPES / VEIGA /  
MALHOTRA 

 

Brazilian Journal of Marketing - BJM 

Revista Brasileira de Marketing – ReMark  
Edição Especial Vol 13, n. 2. Maio/ 2014 

 

the design of the minimum sample required to use 

LISREL, we recommend that researchers use the 

statistical calculator available in 

http://www.danielsoper.com/statcalc3/calc.aspx?id=89 

(accessed March 12, 2014). In general, we recommend 

that SEM models with five or fewer constructs, each 

with more than three measured variables, should be 

estimated with sample sizes of at least 200. For more 

complex models, the sample size should be larger 

(Malhotra 2010). 

     There are several recommendations of steps 

for construction of structural models with LISREL. 

Some are slightly more complex (see Byrne, 1998) 

and others are simple (as in Diamontopoulos and 

Siguaw, 2000). Our choice for this article is a 

simplified and pragmatic approach, which facilitates 

initial learning and can be adapted to more complex 

situations. We suggest an approach in five phases as 

shown in Figure 1. 

 

 
 

Figure 1 - Phases proposed for SEM with LISREL 

      

 

Phase 1 (Development of the Model) is the 

stage in which the researcher elaborates the conceptual 

model - also called the theoretical model - supporting 

associations between constructs (or latent variables) 

and also between the manifest and latent variables. 

Each relationship between variables (covariance or 

effect) comes from a pre-existing hypothesis, because 

the models tested with SEM rely on theories whose 

consistency to empirical data is verified. For example, 

the effect of one latent variable on another 

presupposes the existence of a causal relationship and 

the test result indicates whether this relationship is 

plausible. 

In Phase 2, the conceptual model is designed as 

a path diagram in which all relationships are 

represented. This phase is simple, yet important 

because it is through the graphical illustration that the 

researcher will introduce the variables in LISREL. For 

this phase the symbols presented in section 2.1 will be 

used. 

 

2.1. Symbols and conventions used in the LISREL 

 

The elements of structural models are 

symbolized the same way, regardless of the software 

you use for your analysis. Figure 2 shows how the 

elements are commonly represented. 

 

 

Phase 1

Development of 
the model

Phase 2

Preparation of 
graphic illustration 

of the model

Phase 3

Analysis of the 
measurement  

model (s)

Phase 4

Verification of 
indicators of 

model fit

Phase 5

Analysis of the 
structural model 

http://www.danielsoper.com/statcalc3/calc.aspx?id=89
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Figure 2 – Symbols of structural models. 

      

Structural models treated in LISREL use a convention about their elements, and these matrices, in general, are 

represented by Greek letters (see Table 2). 

 

Table 2 – Matrices of LISREL 

 

ELEMEN

T 
MATRIX 

ELEMENT 

OF  MATRIX 

SOFTWARE 

CODE 

TYPE OF 

MATRIX 
CHARACTERISTICS 

Measurement Model 

Lambda-x x x LX Regression 
Manifest variables to measure the 

exogenous latent variables 

Lambda-y y y LY Regression 
Manifest variables to measure the 

endogenous latent variables 

Theta delta   TD Covariance 
Error associated with the exogenous 

manifest variables 

Theta 

épsilon 
  TE Covariance 

Error associated with the 

endogenous manifest variables 

STRUCTURAL MODEL 

Gama   GA Regression 

Coefficient of the relationship 

between an independent variable and 

a dependent variable of the model 

 

Beta   BE Regression 

Coefficient of relationship between 

two dependent variables of the 

model 

Phi   PH Covariance Covariance between latent variables 

Psi   PS Covariance 
Covariance between manifest 

variables 

Ksi   - Vector Exogenous latent variables 

Eta   - Vector Endogenous latent variables 

Zeta   - Vector 

Error associated with the 

measurement of the dependent 

variables of the model 
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To facilitate understanding of the 

representativeness of letters and matrices in Table 2 

and the symbols shown in Figure 2, we show in Figure 

3 a complete structural model. 

 

 

Figure 3 – Structural Model 

 
 

     

Even beginners in quantitative data analysis 

conclude that it is not possible to analyze the data 

illustrated in Figure 3 by means of linear regression 

model, as there is more than one dependent variable 

(1 and 2 ), plus there is a variable that is dependent 

and independent at the same time (1). 

The SEM through LISREL allows 

simultaneous estimation of a series of separate,  but 

interdependent, equations, incorporating in the 

calculations both latent variables and manifest 

variables and measurement error by checking the 

direct, indirect, and total relations, even though, in the 

model, there are variables that act as both dependent 

and independent variables. The model is statistically 

tested through simultaneous analysis of all matrices of 

variables, through which we could assess the quality 

of fit between the theorized model and the data used in 

the analysis and estimation of variance, and 

covariance effects between variables. 

     Phase 3 is the stage in which the researcher 

analyzes the model of measurement of the structural 

model. A structural model is composed of two sub-

models (often called models for simplicity): (sub) 

measurement model (or measures) and (sub) structural 

model (or relationships between constructs). 

Gerbin and Anderson (1988) recommended 

that the SEM is performed in two stages. At first, the 

researcher must analyze the models for measuring and 

verifying the convergent validity and discriminant 

validity of the constructs. Second, the researcher must, 

analyze the structural model, i.e., referring to the 

associations between the constructs (latent variables). 

Gerbin and Anderson teach that convergent 

validity is demonstrated when loads of the manifest 

variables are above 0.60 (matrix Lambda -x and y). 

Discriminant validity is checked by examining the 

magnitude of the correlations between the latent 

variables of the model. The existence of discriminant 

validity is concluded when Phi () (correlations 

between latent variables) matrices are lower (or at 

most equal) to 0.60. Figure 4 illustrates this analysis. 

Another measure that is used to assess convergent 

validity is the average variance extracted (AVE), 

which is defined as the variance in the indicators or 

observed variables that is explained by the latent 

construct. Cross-loadings indicate lack of 

distinctiveness and present potential problems in 

establishing discriminant validity. Discriminant 

validity is established by showing that the average 

variance extracted is greater than the square of the 

correlations. 
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Figure 4 – Verification of discriminant and convergent validities. 

 

     

We recommend that the manifest variables that 

do not show minimum loads should be eliminated, 

thus favoring the convergent validity, and also the 

parsimony of the model. Similarly, if any Phi matrix 

exhibits a higher correlation than recommended, this 

suggests that the correlations between the manifest 

variables should be measured. The ones with higher 

correlation with other constructs should be discarded 

or added to the other constructs. However, the 

relevance of such changes to the model should be 

verified with the test data from other samples to 

ensure the final model is not about mere artifacts.  

After the analysis of measurement models, the 

researcher must examine the fit indices of the model, 

as indicated in Phase 4, as well as the magnitude of 

variance, covariance, and effects. 

 

2.2 Indicators of model fit 

 

There are different approaches to estimate the 

fit of models in SEM. Different measures that capture 

different aspects of fit should be assessed (Hair et al., 

1988).  Absolute fit indices estimate the quality of the 

overall fit of the model, collectively considering the 

structural and measurement models, regardless of 

model complexity and the number of estimated 

parameters. Absolute fit indices are based on the 

equivalence of the covariance matrix of the data and 

the matrix implied by the model represented. 

Incremental fit indices compare the model with a null 

model (the simplest model that can be theoretically 

justified, usually composed of a single construct 

related to all manifest variables without measurement 

error), rewarding models with higher increments. 

Parsimonious fit indices measure the overall quality of 

fit considering the number of estimated coefficients, 

correcting for any excessive fit. 

The LISREL provides a fairly extensive list of 

indicators of fit. Although scholars have not reached 

consensus on what are the most appropriate indicators 

(Bentler et al., 2001), the vast majority of users of 

LISREL indicate the RMSEA, GFI, RMSR, and the 

chi-square divided by degrees of freedom of the model 

are more robust indicators of absolute fit, while 

indicating NNFI, and CFI PGFI are the most 

important indices for incremental fit. Moreover, the 

AGFI is a widely used parsimonious fit index. Table 3 

describes each. 
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Table 3 - Indicators of structural fit models 

 

INDICATOR 
TYPE OF 

INDICATOR 
DESCRIPTION 

REFERENCE 

VALUES 



Chi-square) 

 

Absolute fit 

index 

Indicates the discrepancy between the proposed 

model and the model by the researcher suggested 

by the data sample. 

p > 0.05 

/d.f. 

(Chi-square divided by 

the degrees of freedom) 

Absolute fit 

index 

As the chi-square is sensitive to sample size, their 

analysis only makes sense when the degrees of 

freedom are considered. 

Between 1 and 

3 good fit 

To 5 reasonable 

fit 

RMSEA 

(Root Mean Square 

Error of approximation) 

Absolute fit 

index 

Shows the fit of the model to the covariance 

matrix of the sample, taking into account the 

degrees of freedom. 

< 0.08 

reasonable fit 

< 0.05 good fit 

GFI 

(Goodness of Fit Index) 

Absolute fit 

index 

Comparison residuals of squares of the model 

versus the model suggested by the sample. 
>= 0.90 

AGFI 

(Adjusted Goodness of 

Fit Index) 

Absolute fit 

index 
GFI adjusted by the degrees of freedom. 

>= 0.90 

 

NNFI 

(Non-normed Fit Index) 

Incremental 

fit index 

Shows whether and to what extent the quality of 

fit of the model is better than the base model. 
>= 0.90 

CFI 

(Comparative Fit Index) 

Incremental 

fit index 

Shows whether and to what extent the quality of 

the fit of the proposed model is better than the 

base model. 

>= 0.90 

RMSR 

(Root Mean Square 

Residual) 

Incremental 

fit index 

It is the average difference between residuals 

implicated by the covariance matrix of the 

theoretical model and the covariance matrix of 

the sample data. 

<=0.05 

PGFI 

(Parsimony Goodness of 

Fit Index) 

Incremental 

fit index 
Measure of model complexity. 

<= 0.67 

acceptable fit 

<= 0.50 good fit 
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Finally, the researcher must go to Phase 5, 

performing the analysis of the coefficients of the 

structural model through the identification of 

correlations between latent variables ( and ), 

coefficients of determination (R2), and significance of 

associations and effects (t tests). . In moving from the 

measurement model to the structural model, the 

emphasis shifts from the relationships between latent 

constructs and the observed variables to the nature and 

magnitude of the relationships between constructs.   

In the next section, we present a textbook 

example of using LISREL through its graphical 

interface: Path Diagram. 

 

 

 

 

 

 

 

 

 

3 A DIDACTIC APPLICATION OF LISREL  

 

Despite being known as complex software, 

LISREL provides several ways for the researcher to 

test the collected data. We will use this textbook 

example of Path Diagram to consider the simplest case 

for beginners.  

In this example, we use for didactic purposes, a 

model with only three latent variables (Attitude, 

Behavior, and Intention) and 10 operationalized 

manifest variables, Atit1 to Atit4 (Attitude), Behav1 to 

Behav3 (Behavior) and Int1 to Int3 (Intention to). In 

our theoretical model we hypothetize that the 

construct Attitude is antecedent of Intention and 

Behavior (dependent variable in the model). Also, 

Intention, even as a dependent variable (of the 

Attitude), is also a variable explaining the behavior of 

the individual. The variables are presented in 

Appendix 1. 

 

 

 

 

 

 

 

 

 

 

Figure 5 – Theoretical Model 

 

 

The first step in modeling is to import the data 

matrix as the basis for testing the theoretical model. 

The LISREL can import data from files of various 

software packages (SAS, Minitab, Excel, Stata, SPSS, 

and others). The import file is quite simple (we use the 

File => Import External Data in Other Formats 

command). Once properly read by LISREL, the data 

file must be saved with the extension .psf.  

     With the data file already loaded in 

LISREL, the investigator should indicate the nature of 

the variables used in the model. In this case study, the 

variables were measured using a Likert scale of 11 

points (anchored at 0 and 10). From a strictly technical 

standpoint, the scale is ordinal; however, Likert scales 

are often treated as interval, which we will adopt as a 

premise. Via Data => Define command variables 

classify the variables of the study, as indicated in 

Figure 6. 
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Figure 6 – Classification of variables 

 

     

      With the File => New => Path Diagram command we started a new project of SEM, as shown in Figure 7. 

 

 
 

Figure 7 - Start of new project of SEM by path diagram 
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The manifest variables of the model are 

imported into the new SEM project when the .psf file 

type is loaded to the new project. As the latent 

variables are not measured and therefore not included 

in the file, this should be stated in the program as 

indicated in Figure 8. 

 

 

 

 

 
 

Figure 8 - Inclusion of the latent variables of the model 

 

  

Then the researcher must assemble the 

measurement model on the LISREL screen. For this, 

you drag the manifest variables and the latent 

variables, indicating the relationship between them. 

 

 

 
 

Figure 9 - Introduction of latent and manifest variables in LISREL 
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Because this is the measurement model, the 

theoretical relationships between the latent variables 

should not be listed at this stage.  Once the layout of 

the measurement model is finalized through the F5 

command, LISREL calculates and Lambda Phi check 

matrices for convergent and discriminant validity of 

the measurement model. As can be seen in Figure 9, 

the convergent validity was established, however the 

discriminant validity, not observed by the correction 

between attitude and behavior, was greater than 0.60 

(= 0.65). With this, using SPSS, LISREL checked 

the manifest variables that showed the highest 

correlation coefficients and, consequently, must be 

causing the lack of discriminant validity between the 

constructs that operationalize. 

 

 
 

Figure 10 – Model of measures calculated. 

 

With the identification of the obvious correlation between the two variables, items with higher cross-

correlation between the constructs were removed. 

 

 
 

Figure 11 - Matrix of bivariate correlation between attitude and behavior generated in SPSS v.18. 
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After the elimination of two manifest variables 

in the model, we can see that the correlation between 

attitude and behavior ( = 0.52) was within the proper 

limits. With this, we pass to the analysis of relations 

between the latent variables i.e., the analysis of the 

structural model. 

 

 

 

 
 

Figure 12 - Model of the variables measured after purification 

 
   

Still in the LISREL screen, we established the 

relationship between the latent variables (structural 

paths) and, again through the F5 key request, the 

structural model. The result of this step is shown in 

Figure 13. 

 

 

 

 

 
 

Figure 13 – Structural Model 
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     Besides the path diagram, LISREL has an output with indicators of fit of the model as presented in Figure 14. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 14 - Indicators of structural fit model 

    

 

After analyzing the suitability of the indicators 

of model fit, the researcher can analyze the 

coefficients and significance of the structural paths 

and verify the explanatory power of the model for the 

dependent variables of the study. At this stage, the 

researcher compares the structural relations with the 

previously conceived theoretical hypotheses.  

The LISREL also provides the development of 

SEM through two programming languages - the 

LISREL and Simplis. Figures 15 and 16 show the 

practical example used in this article constructed in 

these two syntaxes. For details of this type of 

programming, we recommend reading Byrne (1998). 

 

 

 

 

 

 

 

Goodness of Fit Statistics 
 

Degrees of Freedom = 17  

Minimum Fit Function Chi-Square = 50.57 (P = 0.0)  

Estimated Non-centrality Parameter (NCP) = 389.56  

90 Percent Confidence Interval for NCP = (327.59 ; 458.95)  

 

Minimum Fit Function Value = 0.65  

Population Discrepancy Function Value (F0) = 0.52  

90 Percent Confidence Interval for F0 = (0.44 ; 0.61)  

Root Mean Square Error of Approximation (RMSEA) = 0.07  

90 Percent Confidence Interval for RMSEA = (0.06 ; 0.09)  

P-Value for Test of Close Fit (RMSEA < 0.05) = 0.00  

 

Expected Cross-Validation Index (ECVI) = 0.59  

90 Percent Confidence Interval for ECVI = (0.51 ; 0.69)  

ECVI for Saturated Model = 0.096  

ECVI for Independence Model = 4.00  

 

Chi-Square for Independence Model with 28 Degrees of Freedom = 

2976.26  

Independence AIC = 2992.26  

Model AIC = 444.56  

Saturated AIC = 72.00  

Independence CAIC = 3037.22  

Model CAIC = 551.34  

Saturated CAIC = 274.32  

 

Normed Fit Index (NFI) = 0.94  

Non-Normed Fit Index (NNFI) = 0.94  

Parsimony Normed Fit Index (PNFI) = 0.51  

Comparative Fit Index (CFI) = 0.91  

Incremental Fit Index (IFI) = 0.92  

Relative Fit Index (RFI) = 0.93  

 

Critical N (CN) = 52.33  

Root Mean Square Residual (RMR) = 208.87  

Standardized RMR = 0.02  

Goodness of Fit Index (GFI) = 0.91  

Adjusted Goodness of Fit Index (AGFI) = 0.95  

Parsimony Goodness of Fit Index (PGFI) = 0.92  
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Figure 15 – Example of Simplis                                            Figure 16 – Example of LISREL 

 

 

 

4 FINAL THOUGHTS 

 

Structural equation modeling used to estimate 

theoretical models is a common practice in applied 

research in the social sciences and especially in 

marketing research. 

The use of covariance matrices is identified as 

most appropriate for the analysis of social phenomena. 

Covariance matrices contribute more information 

about behavior when compared with correlation 

matrices, which show only standardized data (Hair et 

al., 1998). Furthermore the most important algorithms 

for estimating structural models assume the use of 

covariance matrices. Therefore, the use of software 

that addresses these arrays is critical to scientific 

development. At the same time, LISREL is touted as a 

robust tool for this type of application. 

The purpose of this article was to present, in a 

simple way, the characteristics of LISREL and the 

benefits of its use, in the hope of enlisting new 

researchers and reducing the perceived difficulty of 

using this software. We have also provided helpful 

guidelines to enable the proper use of this technique. 

Although we have not eliminated all doubts, we hope 

to have contributed, even modestly, to the spread and 

frequent use of this excellent structural equation 

modeling software. 
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SYSTEM FILE from file 'C:\Users\ Desktop\ Remark 

- Lopes, Veiga and Malhotra               REMARK.DSF' 

Latent Variables  attitude behavior intention  

Relationships 

ATTIT1 = 1.00*attitude  

ATTIT2 = attitude  

BEHAV1 = 1.00*behavior  

BEHAV2 = behavior  

BEHAV3 = behavior  

INT1 = 1.00*intention  

INT3 = intention  

INT2 = intention  

behavior = attitude intention  

intention = attitude  

Path Diagram 

End of Problem 

 

TI Modelo de Mensuração - Remark - Lopes, Veiga 

and Malhotra                

DA NI=10 NO=750 MA=CM 

LA 

ATIT1 ATIT2 ATIT3 ATIT4 COMP1 COMP2 

COMP3 INT1 INT3 INT2  

 CM 

FI='C:\Users\Evandro\Desktop\Lisrel_BJMmedida\re

mark.cm' SY  

SE 

 1 2 5 6 7 8 9 10 / 

MO NY=8 NE=3 BE=FU PS=SY TE=SY  

LE 

attitude behavior intention  

FR LY(2,1) LY(4,2) LY(5,2) LY(7,3) LY(8,3) 

BE(2,1) BE(2,3) BE(3,1)  

VA 1 LY(1,1)  

VA 1 LY(3,2)  

VA 1 LY(6,3)  

PD 

OU 

 



 

 
Structural Equation Modeling with use of Lisrel: an initial vision 

    _______________________________________________________________________________  

_______________________________________________________________________________ 

 

 

43 

LOPES / VEIGA /  
MALHOTRA 

 

Brazilian Journal of Marketing - BJM 

Revista Brasileira de Marketing – ReMark  
Edição Especial Vol 13, n. 2. Maio/ 2014 

 

Malhotra, N. K. (2010). Marketing Research: An 

Applied Orientation. 6th edition, Upper Saddle 

River (NJ): Prentice-Hall. 

 

 

 

 

APPENDIX 1 – VARIABLES USED IN THE PRACTICAL STUDY 

 

 

CODE AFFIRMATIVE 

Attit 1 The products of this brand have excellent quality. 

Attit 2 I like a lot many of this brand’s products. 

Attit 3 The evaluated brand is much better than other brands I know. 

Attit 4 This brand attends to my consumer needs. 

Int 1 I intend to keep consuming products of this brand. 

Int 2 I will keep buying products of this brand even if other brands offer good deals. 

Int 3 If I find this brand’s products in the supermarket, I will certainly buy them. 

Behav1 I always bought products of this brand. 

Behav2 When I go to the supermarket, I always buy products of this brand. 

Behav3 I will always recommend this brand’s products to my relatives and friends. 

 

 

 


